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About the Manuals

The following product manuals are available. Please use this table as a reference to request the
appropriate manual as necessary.

Related Manuals

Manual No.

Manual Name (Model Code)

A870GOT Graphic Operation Terminal User's Manual IB-66628
This describes the configuration of the A870GOT hardware, performance, (1DMO050)
specifications, procedures for installing optional modules, offline operation,
and troubleshooting.

AB850GOT Graphic Operation Terminal User's Manual IB-66669
This describes the configuration of the AB50GOT hardware, performance, (1DM038)
specifications, procedures for installing optional modules, offline operation,
and troubleshooting.

AB852GOT Graphic Operation Terminal User's Manual IB-66767
This describes the specifications and performance of the A852GOT main (1DM042)
module, as well as the hardware configuration, procedures for installing op-
tional modules, operation in off-line mode, error codes, and trouble shooting

guidelines. (Inclided in the AB52GOT)

A853GOT Graphic Operation Terminal User's Manual IB-66785
This describes the specifications and performance of the A853GOT main (1DM044)
module, as well as the system configuration. (Inclided in the AB53GOT)

SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual " 1B-66791

(Startup Manual) (1DM179)

This describes the configuration of the ABGOTP system, precautions regard-
ing the configuration, and the specifications of the various functions, as well
as the installation procedures, startup procedures, screen configurations,

and basic operation procedures. {Sold separately)
SW3NIW-ABGOTP Graphic Settings Software Package Operating Manual IB-66793
{Monitor Screen Creation Manual) (1DM176)

This describes procedures for creating monitor screens, monitor functions
that can be used with the AB70GOT, procedures for setting the monitor func-
tions, precautions to be observed when creating monitor screens, and pre-
cautions to be observed when appropriating conventional GOT monitor data

for use with the A870GOT. - (Sold separately)
SW3NIW-ABGOTP Graphic Settings Software Package Operating Manual IB-66794
(Data Transmission/Debugging/Document Creation Manual) (1DM175)

This manual describes the following items.

(1) Procedures for downloading project data to the GOT and uploading data
from the GOT :

(2) Procedures for installing the operating system in the GOT

(3) Procedures for using the ABGOTP as a virtual sequencer and for debug-
ging the GOT

(4) Procedures for outputting created monitor data as a completed document

{Sold separately)




Manual Name

Manual No.
(Model Code)

SW3NIW-ASGOTP Graphic Settings Software Package Operating Manual IB-66795
{Report Functions Manual) (1DM178)
Describes procedures to draw grid lines, set and edit report data using the
report function. {Included in the software package product)
GOT800 Series Operating Manual 1B-66796
{Expanded Functions Manual) (1DM181)

This manual describes the operation procedures for using system monitor
functions, monitor functions for special function modules, and the dedicated
monitor screens used with the circuit monitor functions.  (Sold separately)







Introduction

This manual is designed for first-time users of the GOT800 Series.

We hope you will use it for hands-on practice as you learn how to operate the

equipment.



1. Using the Manuals

When this graphics software is purchased, it comes with six operating manuals. And you get
User's manual for GOT, too. Manuals are categorized according to the purpose for which they are
used. Please read the manual that corresponds to your particular objective in order to become
familiar with the operations and functions of the software.

SW3NIW-A8GOTP Operating Manual

¢ |nstall the graphics software in the com-
puter.

¢ Start up the graphics software.

¢ [ earn fundamental information and basic
operations for the graphics software.

SW3NIW-ABGOTP

Operating

Startup manual

Personal
computer

|

S

Graphics
software

<4Le]

Clock display
1

of operations.

Clock display
12:30

¢ Create simple graphics, monitor using
the GOT, and learn the flow of a series

Contains the same text as this manual.

SW3NIW-ASGOTP
Operating

e Actually create screens for monitoring us-
ing the GOT.
Drawing graphics
Sprite settings
* Edit the data which has been created.

SW3NIW-A8GOTP

Operating

Monitor screen
creation manual

introductory
manual

Line monitor
OConveyor 1
OConveyor 2
———D|

port data.
Create ruled lines.
Set the report data.
Edit the report data.

e To perform report function, create the re-

SW3NIW-A8GOTP
Operating

Report
functions
manual




SW3NIW-ABGOTP

* Install the OS program and communica- Operating

tions driver in the GOT. Data transmission
¢ Download created graphics to the GOT. Debugging o

e Debug graphics between the computer manual

and GOT.
Create data documents.

Circuit monitor

m
TTYY

GOT800 Series
Operating

System monitor

¢ Monitor circuits.

¢ Monitor the system. Expanded | —
e Monitor the special module. ' functions ==n=
manual H prm—

Special module monitor

==

Each of GOT User's Manual

¢ Install optional module(communications
module, power supply module) in the GOT. GoT

e Connect the GOT and PC CPU. User's

e Find out how to attach the GOT and its ex-

ternal dimensions.

1| 1




2. Abbreviations and Symbols Used in This Manual

The following abbreviations and symbols are used in this manual.

Abbreviation/
Terminology

Contents

Graphics software

This refers to the SW3NIW-A8GOTP.

Computer This refers to the peripheral device in which the graphics software has been installed.
A870GOT This indicates the A870GOT Graphic Operation Terminal.

A850GOT This indicates the A850GOT Graphic Operation Terminal.

A851GOT This indicates the A851GOT Graphic Operation Terminal.

A852GOT This indicates the A852GOT Graphic Operation Terminal.

A853GOT This indicates the A853GOT Graphic Operation Terminal.

A85LIGOT This refers to the AB50GOT/A851GOT/A852GOT/A853GOT.

GOT This refers to the A870GOT/A850GOT/A851GOT/A852GOT/A853GOT/A810GOT.

Conventional GOT

This indicates the A77GOT (S3/S5).

Canvas graphics

‘| This indicates graphics and text data for still images.

Sprite

This refers to setting data used for moving images.

Screen data

This is the data specified for canvas graphics and sprites, in units of one screen.

Common screen data

This is the data for the specified GOT type and screen switching device.

Comment data

This is character string data created in order to display comments with the message
display function.

Parts data

This is graphic data registered in order to display graphics with the part display function.

Title data

This is title data that comes with each of the various screens.

Project data

This refers to all of the data that has been created, and all of the data saved in the
specified directory.

Contents

This indicates a command on a menu.

This indicates an icon on the tool bar.

This indicates a tab on a dialog box.

This indicates a name of a command in a command box.

This indicates a displayed dialog box.

This indicates an item in a dialog box for which a setting can be entered.

This indicates a dialog box command button.

This indicates a key on the computer keyboard.

This indicates that the information is particularly important.




The Contents and Purpose of This Manual

This manual is designed to let you gain hands-on experience with the GOT as you learn. The
manual is configured of the following chapters:

1. First, Let's Boot the Software!

In this chapter, you will learn basic operations such as installing the SW-A8GOTP in the
computer, starting up the software, and exiting the software.

2. Let's Draw Pictures!

This chapter describes how to draw and edit figures, and how to create simple screens, with
plenty of hands-on practice.

3. Let's Get the GOT Going!

In this chapter, you will learn how to connect the computer and the A870GOT, and how to send
the necessary data to the A870GOT.

4. On the Move

This chapter shows you how to monitor the screens you created in Chapter 2 and how to
check movements.

5. Creating a Screen

This chapter explains more about creating new screens.

6. Creating a Second Screen

Here, you'll learn how to add a second screen to the one you created in Chapter 5.

7. Checking Movements

This chapter describes how to monitor the screens you created in Chapters 5 and 6, and check
the actual movements.



System Configuration Used in This Manual

SW3NIW-ABGOTP

IBM PC/ AT or
IBM PC/ AT compatible
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First, Let's Boot the Software!






1. First, Let's Boot the Software! MELSEC GOT

1. First, Let's Boot the Software!

1.1 Learning the Basics

In this chapter, you will learn basic operations, such as using the mouse, the meanings of keys,
and items on the menus.

1.1.1  Using the Mouse

Clicking ...

Clicking means pressing the button once and re-
leasing it, without moving the mouse.

Double-clicking ...

Double-clicking means pressing the button twice
within a specified time and releasing it, without
moving the mouse.

Dragging ...

Dragging means holding down the button as you
move the mouse.

Clicking, double-clicking, and dragging are all done with the
left button of the mouse.

Now, when we use the words “click”, “double-click”, and

Left butt I
“drag”, you'll know what they mean. et buffon ony
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1.1.2 Screen Configuration

Title bar

This is where the names of the window and the screen are displayed.

Menu bar

A menu is selected by clicking on it fo display a drop-down menu.

|_— Drop-down menu
Project(P) Ed#(E} Draw(D) K [
= GEEY ‘ EE ftems on the menu are
. ) D selected by clicking on them.
L: f—1 104 insta |1 [¢f cussert 76 [s] | 100% |4}
= Memory(M) = : *
Memory Card(C) Document window
Debug(Q)... {Screen window)
hd
- >
+|
- N -
i ftes. No fi = I=
Please select flgjres or sprites. I[ o title | \w \4
— Tool bar \ Status bar Scroll bars
information about the current screen is The scroll bars can be moved to display
displayed here. sections of the document window that

aren’t currently visible.

Tab
Clicking on this changes the page.

hapnes Atribote
U
Pattern

Width

Command button

Cancel

____‘] ¥|

Clicking on this enters the settings.

Command button

Clicking on this closes the window without saving the
settings.
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Spin box
Spin buttons

Clicking on these increases or decreases the numeric value in the spin box by 1.

Mamerical Dizplas

DispJay Format Expression($¥)

List box

Trigger

S N A
x: [0 |I|,Gu %)[

Clicking on this displays a list of the
various types of data.

ok ]

~Monitor device($$)

[ 0-FF DO

Cancel I

Radio button

r Display style
[Signed decimal  [#] Digits:

O Left alignment ight alignment

Clicking on this selects the item.

Check box

Default Color: D |Norm. | Blink: lNo |

Clicking on this selects the item, or
cancels the item if it has already been
selected.
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Describe the way to install GOTS800PSET.

Turn on the power supply to the computer.

y

Start up MS-Windows Ver. 3.1 or Windows 95.

J

insert the floppy disk in the drive of the SW3NIW-A8GOTP 1/6.
Check the drive into which the disk has been inserted.

J

Execute [Set up-exe] on the floppy disk.

J

After setting (@) to (® on the screen below, click on| Install |.
The installation process begins.

[Screen to be displayed]

E’ Setup wil place SWININW-GOTS00PSET into the following
directories, which it wil create on your hard disk.
If you want to install SW3NIW-GOTB00PSET in different
directories andjor drives, type the name of the directories.

EW3INIW-ABGOTP [Draw , Refjort) —— —®
Install to: |C:\-‘\3G0TP I Browse

—
PWINIW-ABSYSP (ABZ0/81DGOT,AB5%GOT)
[csGoTRIOS | [ Browse —— ()
| Browse

Install to:

g

Install to: I CMBGOTPABGMDY

O]



1. First, Let's Boot the Software! MELSEC GOT

[Setting contents]
() Check box

Place an “X* mark in the check box of CISW3NIW-AS8GOTP, [ISW3NIW-A8SYSP, or LISW3NIW-
A8GMDP.

(The check box of SW3NIW-A8GMDP does not need to be selected when the special function
module monitor function is not being used. )

@ ltem button.

Set the item to set up and sample screen to install.

Graphic software is installed. ~ Graphic software for reports isinstalled.

Install It
ns Ems | oK
ASGOTP[Draw] Report Editor
BdiBasic figure Library — .
§ 1 Set the library number where
Install to Library No. |50 the basic graphics library will be
— installed.

® button

Click on , specify the installation destination password of the SW3NIW-A8GOTP,
SW3NIW-SYSP, or SW3NIW-ABGMDP.

Select the directory of the installation destination.

-—_—_E?———l

Files: Directories:
atgorp.got 7
autoexec.bat 5 bat
autoexec.w4l 3 bin
autoexec.you
base0002.a8 g gd"""
chgwin.exe 08
command.com €1 hyper
command.w40 £ melsc
config.sys £ mwave
config.w40 £ mwave_c
dosime.sys £ mwd
hardboot.com + £ mww r
Space Available: Drives:
214,769,664  byte [E=le winDowsses] T3] gelig:t tthe drive of the installation
estinaton.
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® | OS Select | button

Clicking on | OS Select|, select the GOT to use, OS program and communication driver to be
installed in the [Item Select]dialog box.

Select the GOT to use.

Please click left button to move items from 'Install* / 'Not instail' to
'Not install' { "Install'.

rGOT Type
AB70/810GOT

Not install: Install:
Standard monitor |+
ROM_BIOS N

:> gystem monitor Select the function which will be
- p. unit monitor . s

MELSEC.A Ladder monitor | installed or not by clicking
MELSEC-FX Ladder monitor +

(® |Module Select | button

Cliking on Module Select , select the special function module monitor data to be installed in the
[ltem Select] dialog box.

I Select ltem I

Please click left button to move items from ‘Install' { *Not install' to
'Not install’ } 'Install".

Not install: Install:

ABZDA-51

A1862DA

AG16DAV , A616DAI
A1SEBDAV , A1S68DAI

ABBAD Select the function which will be
AGBADN —>

installed or not by clicking
A1S68AD <
AB4AD
AB1BAD
A1S64AD
AB16TD

[ I+

]
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1.3 Starting Up and Exiting the Graphics Software

When the program has been installed, you can try starting and exiting it.
[START] Boot the Windows program.

= Program Manager n -
File Options Window Help
+
(A1 &
- A2 = =)
A =
PIF Editor MS-DOS Read Me Winfile Control
Prompt
Printman ik
[+]
11 IC

Project(P) Edit(E} Draw{D) Communication{C) Common(Q}

Screen(S) 2

#] [=l[ ]~ olafo] Jala[[w] [s[e]m] ]|

-

Lsf — [e]—1 || 3 [2] pattern:| none ][ [T 2] cursor:| 16 [=] | 1005 2|

]

[ I+

Please select figures or sprites.

[l No tite ]

X=223, Y= 1

1) |23 8] Doubleclickonthis.
GOT800 | |
=1 GOTe00 [ v]a
©

Double-click on this
SW3NIW-ASGOTP

[ABGOTP startup completed]
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Project(P} Edit(E) Draw(D) Comrnunahon(g

Common(0) Screen(S) 2

2| [s[[/I-[O[alo]Ja]a[[W] [¢]e

@/ [

L- £} —1 |£|[] |#| Pattern:| None

-

+| ] |¢| cursor:| 16 J¢] [ 1005 ¢]

v|a

|

[ I+

Please select figures or sprites.

Il No titie 1

k=223, Y= 1

Project(P} Edit() Draw{D) Communication{C) Common(Q) Screen(8) 2
Newll) criN ITa[a[[n] [4[e]®] [m[w]
g:)c;l;((%)) Ctrl+0 &! Pattern:| None [¢]|[] [# Cursor:l 16 I!I |1Dl]% H
Save(s) Ctrl+$ hel s
Save As(A)...
Import File(D) 4
Print(P}... Ctrl+P
Option(T) »
Exit(X) Alt+F4
hd
* »

«]

[ 1+

Please select figures or sprifes.

[[ No title 1

=228, Y= 37

Program Manager
Eile QOptions Window Help

Winfile

PIFEditor  MS-DOS

Prompt

Read Me

Printman

Contral

‘ Click on the “Project (P)” position.

‘ Click on “Exit ASGOTP (X)".

[ABGOTP exited]
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14 Learning the Overall Flow

Before you actually try creating a screen, let’s look at the whole series of operations.

{ Start ’

y

Install the software package (SWI-A8GOTP). I

y

Create the user-specified screen data. I

Y

Connect the GOT and computer through the RS232C,
and turn on the power supply to the GOT.

Is this the first time

the GOT is being used?

Install the OS and communications driver.

Send the user-specified screen data. I

Connect the sequencer and start the program
(turn off the power supply to the GOT).
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1.5 Operating After Starting Up Graphic Software

After booting the graphics software, set the GOT type in the screen data as the first operation to
be run.

Project(P} Edit(E) Draw(D) Communication{C} Common(Q} ScreeniS) 2 Click on the “Gommon settlngs
2] [e][/[/[0]a]o] a[a] [x] [¢[m[®] [=]] menu.
<] —1 || 7 || pattern:| None  [¢] (T [2] cursor:| 16 [¢] | 1005

= v |a

*

k]

Click on |
Titl=i(T: -

Ser. Switching Device(D)... [
Password(A)...
Hardcopy(H)

System Information{[...
Observe Status{0)

GOT Type(G)...
PC Type(P)...

(a) Click on “A870GOT-TFT, STN".
Click on "A870GOT-EL" when us-
®AB7OBOT- 1T, STN 7 ABTOGOT! ing AB70GOT-EL.

O AB70GOT-EL Click on “A85*GOT-STN,L” when

using the A85[JGOT.
O AB*GOT-STN, L .
(b) Click on :

1-10
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1.6 About the Screen Images Shown in Chapter 2 and After

A part of display contents of the screen images shown in chapter 2 and after in this manual is
different from those of SW3NIW-A8GOTP. However, there should be no problem in selecting
menus or operation of the actual screen.

For the items that are different from the actual screen, read them as corresponding items of the
SW3NIW-A8BGOT screen.



MEMO




Chapter 2

Let's Draw Pictures!
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2. Let’s Draw Pictures!

2.1 Learning to Draw Graphics

In this section, you'll learn how to draw graphics. Try drawing all kinds of pictures for yourself,
using this page as a reference.

2.1.1  Selecting Attributes

Before you create a graphic, you need to select the attributes for it.

[~ w § A

| Project(P) EdHE) Draw(D} Communication(C) Common{Q) Screen(S) 2
& [Ea)B] (k)E| R
None |#][ ] [*| Cursor:| 16 |#] | 100%

' ' / 100%

Click on the amow button inthe | 2[1[1%&
list box to specify the dot unit
by which the figure will be

moved. A00%

e

E-1 Mo fifle

Click on the amrow button in the
list box to specify a line style.

Click on the arrow button in the list

box to specify a line thickness. Click on the arrow button in the list box to

specify the color of the fill pattern.

Click on the arrow button in the list

box to specify a line color. Click on the arrow button in the list box to specify

the way in which the figure will be filled in.

2.1.2 Drawing Straight Lines, Rectangles, Circles, and Arcs

To draw straight lines:
Project(P} Edit(E) Draw{D) Communication(C) Common(0) Screen{S) ¢ )
] [o] [ biOTiol e e e feter 1o Click here:
Lo — || —1 {#{[] |#|Pattern:| None |¢|[]|& Cursor:| 16 ’!| |1IJEI% 2 Example:
B oo IR
[ —

(1) Press the left button at the starting point of the line.

(2) Drag the mouse to move the cursor.

. - (3) Release the button at the ending point.
| [ I+
Please select figures or sprites. |{ No title | (=223, Y= 1

POINT

Rectangles ), circles [Ql, and arcs ] are drawn in the same way.
Referring to the method for drawing straight lines, try drawing a figure.
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2.1.3 Drawing Polygons and Continuous Lines
I N - -|  To draw a polygon:
Project{P) Edit(E) Draw(D) Communication{C} Common(Q} Screen(S} 2 .
] [ [~ [l 2ol Tatst T et fafe 1w Click here: ELSD
Lzl —— [&]—1 |2][] |#| Pattern:| None |2[[] |2 Cursor:| 16 |tl |1nn% s Example: ,/, “L:\:‘:‘\\
- n : Eil______—T_!_ ______ - S
@ o} YO

(@) Click at the starting point of the polygon, and
drag the mouse to point (2) without releasing

s the button.
«] =] @ Release the left button at the second corner
Please select figures or sprifes. Il Mo fifle | H=223, v= 1 position. (This is the same method used to draw

a straight line.)

(® Click the left button at the third cormner position.
(Click on each of the subsequent corner posi-
tions to continue drawing the polygon.)

@ Double-click at the final corner position.

POINT
The same process is used to draw continuous lines [#].

Referring to the process for drawing a polygon, try drawing a figure.

— Attributes can be changed using the Change Attribute menu

The Change Attribute menu can be displayed by selecting | Change Attribute ﬂ on the Edit menu, or by double-
clicking anywhere on the figure. The following contents are displayed.

CFangs Afrits Clicking here displays the Change Attribute screen for the pattern.
Pattern

Clicking here selects the type of line.

Clicking here selects the line width.

After the attributes have been specified, click here.
Click here to close the window without specifying the attributes.

Click on the line color.

Clicking here displays the Change Attribute screen for the graphic.

Clicking here selects the attributes for the graphic.

After the attributes have been specified, click here.

Click here to close the window without specifying the attributes.

Click on the color of the graphic.
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POINT

Figures not painted...

(@ Click on [&].

(@ Set the graphic pattern using “Change attribute menu”.
(® Click on in the “Change attribute menu” and close.
® Click on the graphic to be painted.
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2.1.4 Inputting Text

=Projecf(B) EdiE) Draw(D) Communication{C) Common{O) Screen(S} 2
] [e[[/[/[Ofalo] ala][x] |4 [m]s] [m]e]

| —1 || [] |¢| Pattern:| None [¢[[] [¢ Cursor:I 16 ‘!| 11[1[1%

(1) Click on (Al
(2) Specify the attributes, and click on .
(3) Enter the text, and click on .

4

L:

the display position, and click there.

«] T I»
IPIease select figures or sprites. |[ No title | |X=223, Y= 1

— Setting menu for text graphics

Specify the text attributes.

| l Click here to close the window without specifying the attributes.

[ ok ]| Cancel I |Change gﬂribu’re...’[ r
L

Click here after inputting the text using the keyboard.

Select the text display format.

Chanee sfroote Select the text outline color.

Select the horizontal expansion of the text.
Style:

Select the vertical expansion of the text.
After the attributes have been specified, click here.

Click here to close the window without specifying the attributes.

Click on the color of the text.

Select the direction in which text is to be displayed.
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2.2 Editing Data (Graphics and Sprites)

(1) Select the data to be edited (when one data item is to be selected)
1) Select (click on) X].
2) Click in the selected data Q.

(2) Select the data to be edited (when more than one data item is to be selected)
1) Select (click on) (%].

2) Starting at the top left of the data ¥ to be selected, drag the mouse to the lower right

corner &, forming a box around the data items.

(3) Change the data size {(expansion/reduction)

1) Select %], and, referring to “(1) Select the data to be edited”, select the data to be ex-
panded or reduced.

2) Place the cross-shaped cursor at the block point which marks the starting point of the
selected data {(J, and drag it in the direction in which it is to be expanded or reduced.

POINT

If the or key is held down while changing the size as described in step (2) above,
the following results:

Shift key: Proportional change in shape
Ctrl key: Centered change in shape

The data can be expanded or reduced proportionally.

Various other operations are also available. For more detailed information, please refer to the
instruction manual.
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(4) Move the data
1) Click on [%], and, referring to “(1) Select the data to be edited”, select the data to be moved.

2) Align the arrow-shaped cursor W, with the data to be moved. (The cursor changes to a
cross-shaped cursor 4-.)

3) Holding down the mouse button, drag the cursor to the position to which the data is to be
moved, and release the button.

(5) Editing on other menus

Project(P){ Edit{f) Draw(D) Communication{C} Common{QO}
® l ><|5ﬂzﬂa ofTala[[W] [s]m[] [

Cursor:| 16&| | 1002% (=

Screen(S} 2

Pattern:

Click on the Edit menu and then click on the item to be selected, or click on the correspond-
ing icon to select the item. The data can then be edited. (The contents are outlined below.)

Edit menu
— UNdo.......occceeee This deletes the last change that was made to the data and returns the data to the status it
was in before it was edited. (Only one data item can be recovered.)
— Cut (8. This deletes the selected data from the screen and stores it temporarily.
— Copy B ..o This copies the selected data to a temporary storage area.
— Paste [&] ............ This retrieves the data from the temporary storage area and pastes it on the screen.
— Copy/Paste......... All of the selected data is copied and pasted on the edit screen.
. Edit Text............. This sets the target of the editing or selection as text.
[ Edit Vertex ......... This sets the angles of a continuous line or polygon as the target of the editing or selection.
— Object of FIQUre woveeveeeeneeen. This sets a graphic as the target of the editing or selection.

Selection Sprite vveveee e, This sets a sprite as the target of the editing or selection.
Figure + Sprite ...... This sets a graphic plus a sprite as the target of the editing or selection.

" Select Al ............ This selects all of the targets selected using the| Object of Selection ﬂ command on the Edit menu.
— Group Group ] ...vveeeeenen. This groups the selected data items as one graphic.
Ungroup & .......... This cancels the grouping of the selected data items.
" Rotate/Flip Flip Vertical ........... This reverses the top and bottom of the selected data (except for text
and images).
Flip Horizontal ....... This reverses the left and right sides of the selected data (except for
text and images).
Rotate Left ............ This rotates the selected data (except for images) 90° to the left.

{Continued on next page) 2.6
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(Continued from previous page)

— Align Center ... Aligns the selected data along the center.
il o} FOTURUT Aligns the selected data along the top.
—Top evenly .......... Aligns the selected data along the top, spaced at even intervals.
—Bottom ............... Aligns the selected data along the bottom.
—Left o, Aligns the selected data along the left.
—Left evenly .......... Aligns the selected data along the left, spaced at even intervals.
—Right.....cc.coormneen Aligns the selected data along the right.

— Stacking Order—[Bring to Front...... Positions the selected data at the front of all the screens.

Send to Back...... Positions the selected data at the back of all the screens.

— Attribute ..o Used to change or specify the attributes of the graphic being drawn or already drawn.
— Edit Sprite ................ Used to correct, divert, or delete a sprite.
— Replace Devices........ This changes all of the specified device names and device addresses.

(6) Cutting data
1) Click on [%], and, referring to “(1) Select the data to be edited”, select the data to be cut.
2) Click on on the Edit menu, or on the Cut icon (¥].

(7} Copying data
1) Click on (%], and, referring to “(1) Select the data to be edited”, select the data to be copied.

2) Click on|Copy | on the Edit menu, or on the Copy icon E&.

3) Click on |Paste]] on the Edit menu, or on the Paste icon @, and then click on the position
to which the data is to be copied.

4) After the data which was stored in the temporary storage area is displayed, click on the
position at which the data is to be pasted.

(8) Pasting data
1) Click on|Paste|| on the Edit menu, or on the Paste icon [&].

2) After the data which was stored in the temporary storage area is displayed, click on the
position at which the data is to be pasted.

POINT

Sprites are edited in the same way as graphics (although there are some functions which
cannot be used with sprites).
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2.3 Creating a Screen

In this section, we will try creating a simple screen, in order to see how it’s done. The screen we
create here will be used in Chapters 3 and 4, in order to follow through the entire series of opera-
tions, all the way up to monitoring it with the GOT.

Referring to Sections 2.1 and 2.2, try creating a screen like the one you see here.
The A870GOT and A85[ JGOT have different screen sizes.
Try creating the screen image you see illustrated below using your GOT.

<Screen to create> 4
Clock display

7

-GOT

" Today's date 3§ Current time

2 5 @ A

— Setting the clock

Click on 8.
{ 1

= — Click on [g], and then on the size in
[louch ey lamp__ ; ? “ which text is to be displayed.

Numerical Disp. Ascii Disp. Posificn Size
Datalist Clock h v Bl | v Eﬁ e [1 ] J /Click on [§], and then on the color

Comment Alarm List frem ) Goor: |17 [ Can,cel in which text is to be displayed.
Part Disp. Part Move { ok Ol a;::; \

"Da’re format CIICK on e|ther “Date" or “Time"y

@ yy/mm/dd O dd/mm/yy O mm/ddivy ‘

, AN depending on which item is to be
Click on ' displayed.
‘J’_ . . . Click on the sequence in which the
After clicking on » click on the dispiay date is to be displayed: either year/
position.

month/day, or day/month/year.
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24 Saving the Created Screen Data

Now let's save the data you created in Section 2.3 to a floppy disk.

Project(P) Edit{f) Draw(D) Comrnunon(g

Common(Q) Screen(S) 2

Click on the Project menu.

¢| [wll ]~ o]alol [ala][w] [4]

SHER

L:| — |&]—1 |¢| [ [#| Pattern:| None

(2)

¢ Cursor:| 16 [*| |1|]l]% It|

- ] Click on -Save Asl|.
Project(P) EdHE) Draw(C
New(N) Cirl+N
Open(Q)... Cirl+0
Close(C)
Save(S) Cirl+S
Save As(A)...
Import File(D) »
Print(P)... Ctrl+P
Option(T) 4
Exit(X) Alt+F4
3)
B sewss | /@ ik on M 3.
Directones:
c:\agol Y lick d lect .
[ | B.:\tp /®C|c on @ and select=a
%‘"’::;:f’p [(momy/]\]| @ Enter the directory name from the
g ::ts? keyboard.
| Eapkit | (Example:{s][am]p]T]e])
Drives:
— L @ Click on :

(4) Click on .
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2.5 Reading Data From a Floppy Disk

Now let’s look at how to read out the data that you stored on the floppy disk in Section 2.4. If the
data that you need is already in the document window, you don’t need this step.

[CRENE
Project{P) Edit{E) Draw{D) Communication{C

Common(Q) Screen(8) 2

Click on the Project menu.

] ][ /]~]olafo] Ja]a[[n] [%]m]m] [w]=]
Lef — 2| —1 |&] ] |2| Pattern:| None |#¢[[] |2 Cursor:| 14 |!| |1EII]% |t|
(@)
- Click on [Open
Project(P) Edit{E} Draw([ '
New(N) Cirl+N
Open(Q)... Ctrl+0
Close(C)
Save(S) Ctrl+8
Save As(A)... .
Import File{D) »
Print(P)... Ctrl+P
Option(T) »
Exit(X) Alt+F4
3)
= Save As
Directories: “
| | c:‘aBgotp Y
e m
B = aBgotp ]
] a8gmdp m
(] got87
Mos
— £ pkit |
Drives:
ml- . B

<

1) Click on [3] and specify the floppy
disk drive.

2) Specify the name of the directory
containing the data.

3) Click on .
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3. Let’s Get the GOT Going!

3.1 Connecting the Computer and the GOT

This section describes how to connect the computer and the GOT to send the created data.

POINT

Use an RS-232C cable for
connection!

computer

Rear view

Handling RS-232C cable connected PC <> GOT, see 2-2 in the SW3NIW-A8GOTP operating
manual (Data Transmission/Debugging/Document Creation Manual).
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3.2 Installing the Operating System in the GOT

Here, in preparation for monitoring, we will install the operating system program and the commu-
nications driver in the GOT.

The GOT does not contain the operating system or the communications driver needed for moni-
toring. Before monitoring for the first time, therefore, these must be installed. After the first time,
these programs do not need to be installed again, but if updated versions come out, the same
procedure can be used to update the previous versions of the software.

The procedure is outlined below.

(1)

ﬁﬂ; Click on the Communication menu.
ProjectP) Edit{f) Draw(D) Communication{C) Common{0Q) Screeni8) 2

® .PI”|D|A ofJala][n] [¢[wfm] [m]=] &
s| —1 |2|[] |#| Pattern:| None {2|[] |#| Cursor:| 16

= v |a

L]

100%

L

@ Click on Install { I ) Menu.

Download(D} 3 @ Click on m .
Upload(U)..

QS

RCOM_BIOSIRY...
Memary ()

Memory Card(C)

DebuglG..

()
EEEEESEEeeeee—-1 ——— (D Select “HD".

~Source path

C-YABGOTPYOS B Defautt , " .
€ | Browe] [Defast | [Tl | | 3) Click on “A870/810GOT” or “A85LIGOT”.
~O0T Type to be installed Close . « . - . ]

© ARTI/BI0G0T STErooT j Click on “A85*GOT” when using A85LIGOT.
~Standard monitor O3 Extended function 0S: ® Ciick on|Install |.

@lnstall  ONof instal O Syster monitor [ver 5.1.01 =

. . 113 4 "

Version: Ver 5.1.0 E15p. wit monior Ve 5.1.0] | @ Click on [#] and then on “Bus Connection”.
Comm. driver: E3Ladder morifor for MELSEG=4-1ver 5.1.01
[Not instal [rowton arvr: ® Click on |Install |.

Sizelbyte): 715768 Mot il
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3.3 Downloading Screens

In this section, we will download the screen we created in Chapter 2 to the A870GOT. The proce-
dure is as noted below.

(1)

Click on the Communication menu.

»

Project(P) Edit{E} Draw{D) Communication{C) Common({Q} Screen(§) 2

EiREEEEE NI AOENER

L: e[ —1 |2][] |#|Pattern:| None |2}[ ] |¢|Cursor:| 16 |¢| | 100% |&
@)
Crommunication (g Click on | Download] .
Ulomymiloadi D

Install([} -

Memory{M)
Memory Card(C}

Debug(G)...

| Upload{U)

Click on | Monitor Data | .

Common(Q) Screen(S)

Upload{U)...
Install([)

Memory(M)
Memory Card(C)

Debug(G)...
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Monitor Data Download Click on '
Setting I Base T Window T Others ]

( Select data Download

] Delete old monitor data

Project title:
GOT Type: AB70GOT-TFT, 5TH
Transfer size [byte) 172 Author:

)
I ] C'°+ " [YES|

Data will be downloaded after stopping monitoring.
9 Are pou sure?

The downloading process begins.

Size: o/ 0 byte
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4. On the Move

4.1 Connecting the Computer

In this section, we will connect the PC CPU and the bus, so that we can begin monitoring.

CAUTION

Make sure the power supply is off
before you connect the GOT. ,

/:/ e %

NN

GOT

PC CPU

Expansion cable
Model: AC[|B

POINT

Connect the PC CPU using an expan-
sion cable!

Rear view

lo

A bus connection unit (A7GT-BUS)
is required to connect the bus.
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4.2 Monitoring

Now let’s try monitoring the screen we created in Section 2.3.

<GOT monitor screen>

GOT

Today's date Current time

95/9/20 12:00:00

2 5 o\ A
A

|
/ \

Displays the date (year/month/day) Displays the time

Attention!

The values on this screen will not be displayed correctly unless the CPU date and time have
been set. Use a GPP or similar device to set the CPU date and time.
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5. Creating a Screen

5.1 Setting Up a New Screen

We will now leave the screens we have set up in the previous chapters, and make screens in a
new directory.

ABE0F Click on the Project menu.
Project(P) Edit({E) Draw(D) Communication(C) Common(Q) Screen(S) 2

2| [w[[/[v]Ofalo] Jala[ [N [s]e|m] [m]w)
L: ¢ —1 [¢][] |#|Pattern:| None |*|[] |#|Cursor:| 16

I«

100%

L

@)

Project(P) Edit{E) Draw(L

New(N) Ctrl+N
OpeniQ)... Ctrl+Q
Close(C)
Save(S) Ctrl+S
Save As(Al...
Import File([) >
PrintiP)... Ctrl+P
OptioniT) 3
Exit(X) Alt+F4
@3)
Project(P) Edit(E) Draw(D) Communlca’non(C) Common{Q) Screen(8} 2
2| [l [ [Ofalo] a]] [ [#[m|®] [w]w] [ .
L: sl —1 |#|[] |#|Pattern:| None |&|[] |#|Cursor:| 16 |#| | 100% |+
[ [ [+
Please select figures or sprites. |[ No fitle ] [X:ZZS, ¥= 1
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5.2 Making a Sample Screen

Let's make another screen here.

The A870GOT and A85LJGOT have different screen sizes. Steps ® ~ ® are explained
Try creating the screen image you see illustrated below us- on the following pages.
ing your GOT.

Numeric displays Numeric input

/\ A
Data display panel / \ i
/ \ Data input panel
V4

7 X \
® © ©
L Touch switch
[Ten Key]
ZN 1 XN [N [\
OO0 | oaooad
X00 X001 X02 X03 Y70 Y71 Y72 Y73
[ ZN A N [ N [#
O O =]
X04\ X05 X06 X07 Y74\ Y75 Y76 Y77

\

A\

N\

Lamp display Touch switch

First, try making a screen like the one shown below.

Data display panel Data input panel

[Ten Key|

X00 Xo01 X02 X03 Y70 Y71 Y72 Y73

X04 X05 X06 X07 Y74 Y75 Y76 Y77

Make this screen using
text and squares!
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5.3 Entering Sprite Settings

Here, we'll enter the settings for the sprites on the first screen.

Sprites are only explained here through hands-on practice. For detailed information, please
see the pertinent information manual.

To enter sprite settings ...

(1)

= ’ — Click on 5] .
Project(P) Edit{E) D ommon{O) Screen(S) 2

raw ieatiom(C
e[ [F T Ofalol Tala][w] [4 ][] =]
L: ¢l —1 |£|[] |#|Pattern:| None |#|[_] |#|Cursor:| 16

= v |a

4

1002

Ld

@)
l : X} The sprite menu box is displayed.
Lamo Click on the function to be specified in order to select it, and enter the setting.
Numerical Disp. | Ascii Disp.
Datalist Clock
Comment Alarm History
Alarm List Part Disp.
r Part Move Panelmeter l
Level Trend Chart I
Line Chart Bar Chart
Numerical Inp. Ascii Inp.
Cursor Move Window Pos

Sprites set on the first page

* Numeric displays * Numeric input
* Lamp displays * Touch switches
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* Numeric displays

Click on , and set the moni-

Basic Display Format Expression($V) Trisser tor device (See step (D below).
Size U
A v. o 3 [V:IT_—B He [T 3] TN _ _
~Monitor device($$) Cancel Click on » and speciy the at-

tributes for the text to be displayed

(@ Setting the device

Type: |16bi’r!signed
Device: E 0

Bit position: I:EI Block: I:@ Unit fop [f0:
Nw No.: [ ]

Stafion No.: ® Host © Others | [4]

“ﬂ

[ 0-FF DD |
_ (See step ) below).
 Display style
[Signed decimal__[#] Digits: [6_[§] Decimal point: | [§] 4
O Left alignment @ Right alignment [ Disp. all digits Click on .
Default Color: D |N0rmJ Blink: ﬁ\lo J [ Edit ] U

Click at the location where the nu-
meric value is to be displayed.

— Click on {§], and specify the device.

— Click on the D column to display the I-
shaped cursor, and input the device num-
ber from the keyboard. (The value can be
input either by clicking on the up and down
arrows, or by entering it from the keyboard.)

Click on .

Device used in this exercise

® - D12 ® — D13 (For @ and (®), please refer to the numeric value display section in the

screen on page 5-2.)

Atribute

Color: EE O Reverse
\\_ Blink:

Cancel I

AN

N

Click on [¥] and specify the color in which the text is to be displayed.
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* Numeric input

Click on , and specify the

monitor device (See step (D below).

Size

x 01§ v 0§ Vi H: Clickon.

U

~Monitor device{$$)

[ 0-FF

Cancel I U

| [Bor

Click at the location where the nu-

r Display style

O Left alignment @ Right alignment

|Signed decimal El Digits: lg I% Decimal point; | IE,‘

O Disp. all digits

meric value is to be displayed.

() Setting the device

B e ]

Type: |16bit/signed

— Click on [3], and specify the device.

N No.: [ B

Device: m @b&mcel : ’ (Click on the [6:] column to display the |-

Bit position: I:@ Block: l:l% Unit fop 10: 2 shaped cursor, and input the device number

from the keyboard. (The value can be input
either by clicking on the up and down ar-

Station No.: @ Host O Others I:% rows [, or by entering it from the keyboard.)
Click on .
@
Basic Display Format Data Expression{SV.$¥) Trigger . . .
e |_—Click on , then set the display range.
I I =2 = Ii (See step (@) below)
Delete
LU
(o |

Color: EH [ Reverse

Blink:

®
=-Aﬁribufe

e |

r Display range

<
(AsaH— Click on [All area|.

Device used in this exercise

© — D10 ® — D11 (For © and ®, please refer to the numeric value display section in the

screen on page 5-2.)
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* Lamp displays

Click on , and specify the
monitor device (See step (1) below).

4
Click on , and specify the

lamp attributes (See step (2 below).
U

Click on (Display Format) , and
specify the lamp attributes (See
step (3 below).

Display Format Expression{$¥)

Display Format

xp W 0

r Monitor device($$)
| 0-FF DO

rShape

Defaulfl Lamp: Tet: ||| Bink: [No ||| Edt |

(@ Setting the device
Click on [8], and specify “Bit” as the device

type.
Click on [8], and specify the device.

Click on the E column to display the

Bit position: |:|§_| Block: E:@ Unit top [/0: -L\ I-shaped cursor, and input the device num-
Nw No.: I:% ber from the keyboard. (The value can be

Stafion No.: @ Host O Others E@ input either by clicking on the up and down
arrows [, or by entering it from the key-

board.)
Click on .

Device used in this exercise

X00 ~X07  Set a total of eight devices. (The same procedure is used to set all eight devices.)

(@ Setting the shape

|~ Click on :
507

T Click on the lamp shape
which will be used.
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(3 The way to display
Lamp [X] . . [T
Basio Display Format Display Format erenensn__H— Specify the color of lamp when it is ON/
_ON OFF.
Text: |L€ =: . Lamp: ! oK I Ciick on .
7 Cancel o . .
we [ B w [t [ Click on position at which the lamp is to
R revious .
Biink: Doutine fort | | Tgq | be displayed.
-OFF —
Tod e, #| tamp: |7 -| Tox:
' H: v:
l(_)opy from ON| | Del. | Blink: OOutline font

POINT

When entering several settings in succession, clicking on “Next” copies the contents of the
current information after it has been set.
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* Touch switches

Click on “Device”.

4
FoSTED Click on and set the device
o Avi:fo A - e A ’
x:0_v:p_J - el v v == for which the display is to be
 Display frigger ancel switched. (See step (0) below.)
G ot | | o] [rovi U
Fixed: L%

Click on [g] and select “Basic fig-
ures” for the shape.

Key Text Text string U

\

i Click on ,and in the "Select Fig-

ure" dialog box, select the attributes

for the figure when the device speci-

fied at step (3) as the display switch-

ing device is on.

LEdt |

!
Click on the tab, and enter the settings. (See step 3 on the following page.)
U
@ Setting the device Click on the location at which the touch key is used.

Click on [], and specify the device.

L— Click on the E column to display the
I-shaped cursor, and input the device num-

Device: [ [#] |0000 - % ber from the keyboard. (The value can be

Bit position: l:l—i—] Block: [:I_%l Unit top [/0: E@ input either by clicking on the up and down
NW No.: EEI arrows [, or by entering it from the key-

Station No.: ® Host O Others | [3] board.)
Click on [OK]..

Device used in this exercise

Y70 ~ Y77 Set atotal of eight devices. (The same procedure is used to set all eight devices.)

@ Setting the attributes

> OFF |

swrrc??—J SWITCH 6 SWITCH 7 SWITCH 8
Click on -OK i

Bwich 1] Click on [SWITCH 4]
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Toch ey

Action Trigeer Click on|Bit |and specify the de-
Action Storing device/Switching type vice from which data is to be
[word dev. | [ oK ] read. (See @) below).

| Base | I Cancel]
| Window I I Proviny:

lick on .

| Expanded |

®
= In this exercise, we will enter a set-
ting that turns the touch key alter-

Action Ok nately on and off each time it is
® Set O Alfernate | Cancel \] pressed. To do this, first click on “Al-

O Reset O Momentary Ve ternate” to select it.

Click on and specify the de-

Storing device

i | vice to be used for writing (see be-
low).
Click on .
Setting the device
L — Click on [}, and specify the device.
Type:
’fpe — Click on the D column to
Device: id display the I-shaped cursor, and in-
Bit position: EEI Block: E@ Unit top I/0: put the device number from the key-
Nw No.: E@ board. (The value can be input either
Station No.: @ Host O Others | [&] by clicking on the up and down ar-
rows [, or by entering it from the
keyboard.)
Click on .

Device used in this exercise

Y70 ~ Y77 Set atotal of eight devices. (The same procedure is used to set all eight devices.)

@®  Click on the location where the touch switch is to be activated.
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POINT
Use the following procedure to specify the touch key used to display the ten-key window:

Basic Action

Action Storing device/Switching type

[worddev. ] [ oKk ]
I Base I ICanceII

[Lwindow_] : Click on | Expanded].

| Expanded |

* Select the key window.
Click on .

Enter the settings as shown above.
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6. Creati.ng a Second Screen

6.1 Entering Screen Switching Settings

Before creating a second screen, settings have to be entered that enable you to switch from the
first screen to the second. The following two settings are needed to switch screens:

* Setting the screen switching device (we will use “D999” for practice)

O]

2 Click on the “Common” settings
Project{P) Edit({f) Draw{D} Communication{C) Common{Q) Screen(S) 2 menu.

® .PP’IDM of [a[a][n] [¢]m]®] [me] [ )
s| —1 |#|[] |#|Pattern:| None [#|[] |#|Cursor:| 16

Al

10038

A

Click on [Scr. Switching Device]] .

5 Screen(8) 2

Scr. Switching Device(D)...
Password(A)...
Hardcopy(H)...

System Information([)...
Observe Status(Q}...

GOT Type(B)...
PC Type(P)...

®

Click on .

Switching Soreen Device

Device to switch base
| 0-FF DO |

Cancel I
rDevice to switch window
[ 0-FF | | Dev. |
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Type: |16bit/signed

Device: m Cancel

Bit position: [ [&] Block: [ & unit top L0
Nw No.: [ B

Station No.: ® Host © Others I:%

® Click on .

* Setting the touch key used to switch screens

@

Data display panel

Data input panel

LAL\_J&\/A

X00 Xo01 Xo02

ojole
L\/ALJL\J

X04 X05 X06

N
X03

X07

Oooaad

Y70 Y71

a4da

Y74 Y75

Y72 Y73

a4d

Y76 Y77

Screen 2

/

Project(P)

eI

Edit{E) Draw(D) Communication{C)

Common{Q}

Click on [$] and specify the device (for practice,

we will use “D”).

U

Position the I-shaped cursor to the right of the

U

Click on

Y — [0 B and click. Then enter from
the keyboard.

Let's create our screen using rectangles and text.
You can use any attributes you want.

Create the screen.

Screen(S)

9

Click on [&}.

| g [
L:

ol |af2][x] [4]e

SlEE

— W1 |

[_] |#| Pattern:| None

+{[ ] [#| Cursor:| 16

e

100%

4
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®
Click on .
Lamp
Numerical Disp. Ascii Disp.
Datalist Clock
Comment Alarm History
Alarm List Part Disp.
Part Move Panelmeter
Level Trend Chart
line Chart Bar Chart
l Numerical Inp. Ascii Inp.
l Cursor Move Window Pos

®
= Touch By
Basic Action 1 Teigger . Click on “Action”.
Action Storing device/Switching type U
2l [word dev. | [__OK Click on[Base] .
Base Cancel
I Window |
| Expanded |

[Proviu |
The: |
e |

Meltiple: Davire:

Device
0-FF
0-FF
0-FF
0-FF
0-FF
0-FF
Device fype: IBif

>

—

O | N | =] O MO

® Click on [OK].

Click on “Fixed”.
|

Click on [§. (For this exercise, specify “2", to switch to
the second screen.)

U
Click on .

@ Click on in the screen which you have created. (The screen can be expanded using the same

procedure as for expanding figures.)
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— Screen Switching Devices

When switching screens, the device must always be determined, and must be specified as
the screen switching device.

The data contained in the specified screen switching device will serve as the screen number
displayed on the GOT.

For this reason, the screen switching device number should not be used for any purpose
other than screen switching (it may be used if you are sure the screen switching operation will
not be affected, but should be avoided as a rule).

Generally, word devices such as “D” and “W” should be used as the screen switching device.
A “GD” device can also be used.

The “GD” Devices

The “GD" is an internal vegister of the GOT. GD64 ~ GD1023 devices are available. Because
the “GD” is a device belonging to the GOT itself, it can only be used in the GOT. Devices such
as “D” and “W”, however, belong to the PC CPU, and thus the screen number can be con-
trolled through the sequence program.
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6.2 Making a Sample Second Screen

At this point, let’s make our second screen.

The A870GOT and A85LJGOT have different screen sizes. Sections ® and @ are
Try creating the screen image you see illustrated below us- explained a little later on.

ing your GOT.

Level panels Panel meter displays
A

%/

/ Screeni

Alarm list

A line supply conveyor stopped. Check power.

Screen switcher

Try making a screen like the one shown here.

[Screent




6. Creating a Second Screen MELSEC GOT

First, bring up the editing screen that you need to make the second screen.

&AE0TF Click on the “Screen” menu.
Project(P) Edit{(E) Draw(f) Communication{C) Common(Q) Screen(s) 2

o] [o] T 1ofao Mafal ] [s o[e] ]z
L: #| —1 |£][] |#| Pattern:| None |#|[ ] |#| Cursor:| 16

3]

10028

4=

Click on .

CIear(R
Clear and Load{N)...

Store(S)
Store As{Al...

Scr. Utilize/Delete(U)...

Preview(y) »
Redisplay(D)

Cascade(C)
Tile(D

+B-1 No title

®

— Click on 3 and set the screen numiber to “2”.

Load No.: OK i)
\Click on _
Screen fitle list: Set Hifle...
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First, before setting the sprites, specify any comments to be used on the alarm list display. The procedure and
comments to be set are as shown below.

0

Project(P) Edi{E) Draw(Q) Communication{C} Common(0) Screen{S) 2

2] [ - [oz[o]Salal [N [¢[e[@] [=]e]
L.

Click on the “Draw” menu.

bA
I
¢ —1 |¢|[] |#|Pattern:| None |#[[ ] |#|Cursor:

-

]

-

100% |*

@
BTl Communication{  Click on _
FeqelkitiPi...
Part(R)...
Comment{C)...
Draw Figure(F) »

Data Display(D) »
Message Display(M} »
Animation Display{A) »
Graph(G) >
Touch Key(I)...
Data Input{l} 4
Window Position(w)...
®
Comarent st Click on .
Comment Color Mode Blink
1 [ Cancel |
2
3 [ Edt..’]
4 Delete I
3 Copy... |
6
-7
L d
Comment No.: ]1 L%‘ r Jump | [ I
O]

Fit Comment Input the comment from the keyboard (See below for
Comment: Comment No. 1 comment to be input).
: OK U
L Click on [§] and specify the color in which the com-
+
- o] ment is to be displayed.
rAtiribute : U
caor: T Ok
olor EE Reverse Gick on .
Blink: [No__[+]
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— Comments to Input

1. X0 Aline supply conveyor stopped. Check power.

2. X1 Emergency stop limit switch triggered. Check workpiece.

3. X2 Workpiece limit switch not triggered. Check for workpieces.

4, X3 Oil low in Machine 1. Add ail.

5. X4 No. of workpieces exceeded 100. Replace brush.

6. X5 Problem with arm ascent. Set correct height.

7.X6 Problem with arm descent. Set correct height.

8. X7  Problem with arm limit movement. Set correct horizontal width.

To enter more than one comment, click on the “2” box on the second screen, and repeat
steps (2) and (3). The same procedure is used to enter comments in boxes 3 to 8.

Comment Color Mode Blink

»

Cancel I

‘

Edit...

Delete I
Copy... I

¥

Comment No.: |1 A Jump ]|

~ O U M~ 3 N
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* Level display

Display Format Data Expression{$V)

Click on [] and select “Up”.
4

xi: [0 [ vi: o }%{—xz;|sz/mg

Specify the line color for the canvas
to be used in the level display.

r Display style

4

Direction: ary:

Click on and specify the moni-

tor device (see (@ below).

~Monitor device{$$)

| 0-FF

| Default i Color: Pattern:

U
Click on and specify the at-

tributes for the level display.

U
Click on .
U

Click on the location where the level display is to be produced, and expand it to the size
of the level display. (The location is expanded using the same procedure as for expand-

ing figures.)

(@ Setting the device

Type: |16bitésigned

[AF — &

Device:

Nw No.: [ [4]

Station No.: @ Host < Others I:@

— 0K\ |

Bit posifion: | [4] Block: [ [&] unittop o: [ @

Click on [8], and specify the device.

L— Click on the D column to display the I-
shaped cursor, and input the device num-
ber from the keyboard. (The value can be
input either by clicking on the up and down
arrows [#, or by entering it from the key-
board.)

Click on :

— Devices used in this exercise

® — D12 (® — D13 (For ® and (), see the level display section of the screen)

POINT

The internal coordinates are automatically set to the center of the display frame. With intricate
figures, however, if the center of the figure does not match the internal coordinates, the coor-
dinates can be changed by the user.
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* Panel meter display

Fan= metar Click on and specify the moni-
Display Format Data Expression{$v) tor device (See @ be|OW)_
| U
. Al v. ry
0 lgiv: [0 [§ ‘ Click on [ and select “Upper half-
rMonitor device($$) 3 ) circle”.
| 0-F [Dev./| : 1
Meter style ' Hed Click on and select the attributes
TypedTop /4 [#org.{0° _[#JDirection: [Clockwise [ for the panel display.
Frame Scale Scale points: U
Edit text
[ Edt fod ] Click on[OK] .
IDefaul’rE Color: U

Click on the location where the panel
meter display is to be produced, and
expand it to the size of the panel
meter display. (The location is ex-
panded using the same procedure as
for expanding figures.)

(@) Setting the device

Click on [3], and specify the device.

|_— Click on the D column to display the I-
shaped cursor, and input the device num-
ber from the keyboard. (The value can be
input either by clicking on the up and down
arrows [8, or by entering it from the key-
board.)

Click on .

Type: Hébi’rfsigned
Device: |[|
Bit position: E@ﬁ)ck:

NW No.:
Station No.: ® Host © Others I:EI

— Devices used in this exercise

©— D12 @ — D13 (For @ and @), see the panel meter display section of the screen)

POINT

The upper half-circle used for the panel meter display is displayed automatically when the
panel meter is specified. If this results in white being used as the display color for the outline,
however, or if you want to specify another color for some other reason, use the canvas to do
this ahead of fime.
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* Alarm list display

Llarm st

Display Style

Set “8”, s0 that eight comments can
be used.

X1: [0

CREE

1

l
Click on and specify the moni-

xe: (32§ A §

tor device (see (® below).

rSize

vi [ w [

Comrfient No,—
5] n

l

rMonitor device($$)>

Ple.: |1 &7 O-FF

Click on and specify the stor-

age device (see (b) below).

rStoring device

| 0-FF

Device

0-FF

"

[ Edit J |

o
05
"‘/I

0-FF

0-FF

0-FF

0-FF

ol | 3| M| =

0-FF

Device type: |Bi’r

U
Click on :
y

Click on the location where the alarm
list display is to be produced, and
expand it to the size of the alarm list
display. (The location is expanded
using the same procedure as for ex-
panding figures.)

/Click on “Continuous”.

N

Click on :

- (o) Setting the device

Type: |16bit/signed

Device: E 0
Bit position: I:Ei Block: I:EI Unit top 1/0: l:l%\’ input either by clicking on the up and down
Nw No.: [ [4]

Stafion No.: ® Host O Others [ [

W]

o

Click on [3], and specify the device.

L—Click on the E column to display the I-
shaped cursor, and input the device num-

ber from the keyboard. (The value can be

arrows [§, or by entering it from the key-
board.)

Click on .

Devices used in this exercise

Monitor device: X00 ~ X07 (8 points)

Storage device: D20
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7. Checking Movements

7.1

Monitoring

The values for
D12and D13 are
shown on the
level display.

The values for D12 and D13 are
shown as numeric values.

D10 - D11

/

Data display panel / /

/

Data input panel

3258

|
7296

213

:

143

Downloading the screen we have created and monitoring it produces a screen like that shown
below.

|~ Pressing the touch key displays
the ten-key window.

/ Pressing the touch key changes
to the second screen.

[Ten Key]
l7Z N |7 NN N [# N e
OO0 | oagooaod
X00 XO01 X02 X03 Y70 Y71 Y72 Y73
7z N 7 N 17 N 7 XN
O 010100
X04 X05 X06 X07 Y74 Y75 Y76 Y77
/I Screen2
/

When external inputs X00 ~ X07 are
turned on, the corresponding lamp lights.

Pressing the touch keys turns exter-
nal outputs Y70 ~ Y77 on and off.

W

A

\

7

A line supply conveyor stopped. Check power.

//

The values for D12 and D13
are shown on the panel meter
display.

/Pressing the touch key
changes to the first screen.

Screent

Alarm comments set in advance are displayed by turning on

comments X00 ~ X07.
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7.2 The Sequence Program Used for Practice

M9031 K P K

o —L >= 10 Z1 [+ 1 Z1 H
K K

8 < 10 Z1 [MOV 1 Z1 H

Z1

| (MO0
M1 P K

- — | [MOV 350 D12 H
P K

[MOV 5365 D13 H
M2 P K

: — } [MOV 5250 D12 H
P K

: [MOV 2315 D13 H
M3 P K

i L [MOV 175 D12 H
P K

- {MOV 355 D13 H
M4 P K

: F TMOV 2438 D12 H
P K

- — MOV 3575 D13 H
M5 P K

I L] {MOV 1250 D12 H
P K

- [MOV 5437 D13 H
M6 P K

- — | [MOV 4380 D12 H
P K

- [MOV 6437 D13 H
M7 P K

- — | {MOv 4325 D12 H
P K

i [MOV 7452 D13 H
M8 P K

i -y [MOV 5340 D12 H
P K

i [MOV 4650 D13 H
M9 P K

- — | —{ MOV 4327 D12 H
P K

- [MOV 1250 D13 H
M10 P K

- — | [MoOv 7352 D12 H
P K

- [MOV 355 D13 H

CIRCUIT END
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Appendix

Appendix 1. Supplementary Assignment

Try making a screen like the one shown below.

The A870GOT and AS5LIGOT have different screen sizes. Try creating the screen image you see

illustrated, below using your GOT.

<Base screen>

Product Line

Line Operating Condition .................. E\
Production Condition ~ .................. E/

S Touch Key Setting
(Base switching)

A line Ambient Operating Temperature

Tank A Coolant Water Temperature Abnormal

A line supply conveyor stopped. Check power.

Tank B Coolant Water Temperature Abnormal +7

[> Comment Display

Parameter

Display B line Ambient Operating

Temperature

Product Condition Display
Finish Indicated Count /O‘I 234 Window |

Total Discharged Count / 1234
Aline start A line shut Ola’ Lischarg o / °

= —
@ down |Actual Finished Count // / 01234

- - Producing Accomplishment
B line start B line shut pe,semage P /// Y 012.4%
b down Fl;r}le:;(:aeding

Index

Lamp Display <

Alarm List Display

Touch Key Setting
" (window display)

Touch Key Setting
> (Base switching)

7
Numeric Display

A-1
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Appendix
Numeric Input
A
A line / B line
Packing count 01234 Packing count 01234
Part NO. o012’} [ Partno. o12
Actual count 01234 Actual count 01234
| f—T—' Part Display Numeric Display
Part Move .——— Part Displa:
S\\ . k ( 7 i ,('I[oucE Key Setting
en—key
Tenkey window display)
\ Aline Bline
01234 01234
-
>Touc:h Key Setting
I@/ (Base switching)
age
<Window screen>

_}-Trend Chart Display

60Minutes|
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Try making a canvas screen like the one shown below.

Product Line

Line Operating Condition

Production Condition

A line Ambient Operating Temperature

®

®

B line Ambient Operating
Temperature

Product Condition Display
Finish Indicated Count Window
Aline start A line shut Total Discharged Gount | ®
down |Actual Finished Count ndox
B line start Bline shut |peara 0| @ %
® down ;F;;Z%eding
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A line B line

Packing count @ Packing count @0

Part NO. @ Part NO. @

Actual count vz] Actual count éd

® @
Ten key @
Aline B line
= @
index [ @0

Precedi
=]

o] 30 60Minutesl

* ltems @) to @ do not need to be created in this section.

* The color and attribute do not need to be specified in order to create the screen.
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<Comments to create>

1

o N O O b~ W oON

. Aline supply conveyor stopped. Check power.

. Emergency stop limit switch triggered. Check workpiece.

. Workpiece limit switch not triggered. Check for workpieces.
. Oil low in Machine 1. Add oil.

. No. of workpieces exceeded 100. Replace brush.

. Problem with arm ascent. Set correct height.

. Problem with arm descent. Set correct height.

. Problem with arm limit movement. Set correct horizontal width.

* The contents of comment is same as actual exercise.

<Parts to create>

BHN -1 BHN -2 BHN -3
BHN-4 BHN-5

* Specifying the color and attribute are not necessary for creating.
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<Contents of setting sprites>

No. Sprite Setting Contents

@ | Touch switch | Base switching -+ Fixed value 2

@ | Touch switch | Base switching --- Fixed value 3

® | Panal meter Device -« D10 Half-circle  Minimum value 0 Maximum value 100

@ | Panel meter Device - D11 Half-circle  Minimum value 0  Maximum value 100

® | Comment Device -+ X00 Comment -- Gomment when direct device is on "Take
A coolant water temperature abnormal”

® | Comment Device --- X01  Comment -- Comment when direct device is on “Tank
B coolant water temperature abnormal”

@ | Alarm list Device -+*M0~M7 (8 paints) Plural number Number order storage device - D15

Numeric value | Device --- D30

® | Numeric value | Device --- D31

Numeric value | Device --- D32

@ | Numeric value | Device --- D34

@ | Lamp Device - X06 ON --Light on  OFF ---- Light off

@ | Lamp Device --- X06 ON - Light off  OFF -+ Light on

Lamp Device --- X07 ON --Light on  OFF ---- Light off

@® | Lamp Device - X07 ON - Light off  OFF ---- Light on

Touch switch | Expand --- Window

@ | Touch switch | Base switching -+ Fixed value 1

Touch switch | Base switching -+ Fixed value 3

Numeric input | Device --- D40 Display range - Full range
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No. Sprite Setting Contents

@0 | Numeric input | Device ---- D41 Display range --- Full range

@) | Numeric input | Device --D20  Display range ---0~10

@ | Numeric input | Device ----D25  Display range ---0~10

@ | Numeric value | Device ----CNO

@ | Numeric value | Device - CN1

@ | Part Device ---D20 0<$V<=10 Indirect blink

@ | Part Device -+--D25 0<$V<=10  Indirect blink

) | Part move Device =+ D20 Indirect Coordinate device --D21  Posttioning - Top left
@ | Part move Device - D25 Indirect Coordinate device - D26  Positioning - Top left
@ | Touch switch | Expand-:- Ten-key window

@ | Touch switch | Base switching -+ Fixed vaiue 1

@) | Touch switch | Base switching --- Fixed value 2

@ | Trend chart Device ----D30~D32 Upper limit value 10000  Lower limit value O

Dispaly --- Right Charts --+-3 Points --- 10

* |nitial values should be used for items not included above.

(tems may be changed if necessary.)

* Specifying the color and attribute are not necessary for creating.
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<PC CPU program used in supplementary assignment>

M9031 K oK
0 b >= 10 z ] [+ 1 z
K P K
L < 10 z ] [ MOV 1 z

K P K

L = 1 z ] [MOV 356 D30
P K

. [MOV 2635 D3
- P K

5 [Mov 7538 D82
. P K

s [MOV 235 D34
. P K

3 [MOV 25 D10
P K

- [MOV 26 D11
P K

L [Mov 119 D21
P K

- [MOV 216 D22
P K

- [MOvV 354 D26
P K

3 {Mov 216 D27
K P K

! [= 2 z ] [MOV 5248 D30

K
L MOV 745 D3t

L e e e e e e B o B v S I = T = B = S = S o N == B S B S

P K

- { MOV 2547 D32
P K

- [ Mov 452 D34
P K

- [ MOV 24 D10
P K

- [ mov 24 D11
' P K

- { MoV 32 D21
P K

- { MOV 224 D22
P K

- [ Mov 433 D26
P K

- . [ Mov 224 D27
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M9031 K P K

185— ——{ = 3 z ] { MoV 4275 D30 |
. P K

- [ Mov 2635 D31
- P K

L [ MOV 8472 D32 }
. P K

- [ MOV 857 D34 H
. P K

- [ MoV 27 D10 H
. P K

- [ MoV 26 Di1 |
. P K

- [ MOV ) D2t H
P P K

- [ MOV 304 D22 H
. P K

- [ MoV 433 D26 |
- P K

- [ MoV 304 D27 |
K P K

- U= 4 zZ ] [ MoV 6343 D30 H
. P K

- [ Mov 3563 D31 H
- P K

- [ MoV 7465 D32 |
. P K

L [ MOV 632 D34 |
r P K

- [ MoV 23 D10 H
- P K

- [ MOV 28 Di1 |}
. P K

- [ Mov 32 p21 |
. P K

L [ Mov 384 D2 |
. P K

- [ MoV 433 D26 |
. P K

- [ Mov 384 D27}
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Mg031 K

248 — (= [ MOV 8243 D30 H
K

- [ MOV 6248 D3t H
K

- [ MoV 7354 D32 H
K

- [ Mov 735 D34 H
. K

- [ Mov 24 D10 K
K

- [ Mov 25 Di1
K

- { = [ MoV 4527 D30 H
K

- [ Mov 3485 D3t H
K

- { MOV 7534 D32 H
K

- [ MoV 658 D34 |
K

- [ MoV 30 D10 H
K

- [ MoV 27 D1
K

- = [ Mov 6472 D30 H
K

- [ mov 5365 D31 H
K

- I Mov 2365 D32 H
K

- [ Mov 648 D34 H
K

- { Mov 23 D10 H
. K

- { Mov 25 D11 |
K

- [= [ Mov 5737 D30 H
K

- [ Mov 3424 D31 |
K

- [ Mov 6457 D32 |
K

- I Mov 236 D34 H
K

- [ Mov 24 D10 |
K

- [ Mov 20 D11 |
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M9031 K P K
393 — = 9 z ] [ MoV 4537 D30 H
P K
- I Mov 3623 D31 H
- P K
L [ MOV 8723 D32 }
. P K
: [ MOV 364 D34
. P K
: [ MOV 22 D10 K
. P K
L [ MOV 25 D11
K P K
L = 10 z 7 { Mmov 7646 D30 H
P K
s I MoV 3465 D31 H
r P K
s —{ Mov 7583 D22 H
P K
- [ MOV 846 D34 H
P K
s : — MoV 27 D10 H
P K
s -[ MOV 23 D11 H
D40
- (o
‘ D41
i (¢t N
co
469 1| [ RST co H
]
473+ [ RST ¢t H
M9036  M9031
4771 I (MO Dy
Mg031
- H (M1 D
M9032
| } (M2
M9032
L iy (M3 1
M9033
- — | (M4 D
V9033 .
r + (M5 1
M9032
i } (M6 D
M9032
— 0 (M7 Dy
502 >= co D40 ] [ RST co
510 > = c1 D41 ] [ RST ¢t

CIRCUIT END
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Appendix 2. Getting Familiar With Terminology

This section contains a list of words used in this manual that may be unfamiliar to you.

A
Access key

These keys are used to select a menu item, instead of selecting it from the menu.

The initial letter underlined next to the menu item indicates the access key corresponding to that
item.

<Operation> [ALT] + [Access key]

Accumulator (A)

This is a type of data register. Data is automatically stored here when a particular PC command
is executed. There are two accumulators, AQ and A1. Sixteen-bit data is stored in A0 and 32-bit
data in AO/A1.

Address

This indicates a location in the memory. With the PC, there are various memory devices avail-
able, such as data registers (D) and internal memories (M). Addresses are used to specify the
position of the data within a memory.
Addresses can be expressed in decimal or hexadecimal format.

Hexadecimal format : X, Y, B,W

Decimal format : Anything other than the above

Alignment

Alignment refers to positioning the graphics and sprites in a selected area using a specified
method. Graphics and sprites can be aligned at the top, bottom, left, right, and center, and can
be spaced at even intervals along the top or at the left. Alignment at even intervals along the top
is convenient when you want numeric display sprites or other information to be spaced evenly
across the top of the screen. In this alignment, all of the target items are spaced at even intervals
in the range between the top left coordinates of the leftmest item and the top left coordinates of
the rightmost item.

Ambient operating temperature

This refers to the ambient temperature under which the equipment is used after the power
supply has been turned on. Because the PC is usually installed inside the panel, the ambient
operating temperature is the temperature inside the panel. The GOT may be installed either
inside or outside the panel, so please be aware that the ambient operating temperature changes
depending on which configuration is used. (See below.)
Correct operation cannot be guaranteed outside these ranges:

Display section: 0 ~ 40°C

Sections other than display section: 0 ~ 55°C
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Annunciator (F)

This is special bit information (device) used with information concerning a breakdown or other
specialized types of information. It differs from other devices in that it is processed in the order
in which it is generated in the special data register of the PC.

Attributes (changes)

Parameters such as lines, fill pattems, and text are called “attributes”, and an “attribute change”
refers to checking the status of these parameters.

¢ |ines: Line type, width, and color

¢ Patterns: Pattern type and color

* Text: Vertical expansion ration, horizontal expansion ratio, and color

—B—
Base screen

This refers to the screen on which the entire GOT display area is displayed. It consists of canvas
graphics and sprite settings.

Bit device

This refers to a device which conveys information in 1-bit units within a PC device. With the
GQT, each bit of a word device can be used as a bit device.

Bitmap

This is a file format containing pixel images, and is identified by the file extension “.BMP”. The
GOT can use bitmaps as canvas graphics or parts data. A BMP file can be output using an
image scanner and a commerdcial graphic software program.

Bitmaps are read by selecting “Other Format” under “Read Other Data” on the Project menu.

Buffer memory (BM)

This is a memory inside a special module which is individual to that particular special module. It
can be read directly from the GOT, just as with any other device. With the GOT, however, it
functions only in regard to the local node.

—C—
Calculator link (module)

This refers to connecting the module PC and a calculator (the GOT and a computer) and read-
ing the PC devices. It also refers to the module used to carry out this function.
When the GOT is connected, the communications cassette listed below has to be installed in
the GOT.

A8GT-RS4
With the MELSEC, the following calculator link modules are available:

AJ71QC24 {for the QnACPU)

AJ71QU24 (for the ACPU)

A1SJ71UC24 (for the compact ACPU)

Canvas (figure)

This refers to the fixed information for a screen. It consists of graphic, text, and image data.
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Cascade (menu)

When an item on the menu that has a check mark to the right of it is selected, a sub-menu is
displayed to the right or left of that item. This is called a cascade menu.

Clear

This means to delete information or reset a value to O.

Click

This means pressing the mouse button once and releasing it, without moving the mouse.

Comment

This is text information used for the “Comment display” and “Alarm list display” sprite param-
eters. One comment may consist of up to 512 characters. A maximum of 32,767 comments
can be registered for one screen.

Communications driver

This is one type of system software (operating system) which enables communication with a
PC. There are dedicated drivers for each type of communication (bus connection, CPU connec-
tion, etc.), so always use the operating system installation function to install the driver in the
GOT.

Control menu (box)

This refers to the command menu used for window operations such as formatting the screen as
an icon or closing the window. The button used to open this menu is called the control menu
box.

The control menu box for the Application window is located at the left end of the title bar. The
control menu box for Document windows is located at the left end of the menu bar.

Control node

For the MELSECNET/10, this is the node which controls the overall network. There is only one
control node per network. Should a problem of any kind occur with the control node, normally
one node takes over as a sub-control node (control node shift function) to continue linking data.
When the GOT is connected to the MELSECNET/10, setting the address number of the monitor
device to “0” serves as a control node setting. If the address number of the monitor device has
been set to “0”, the GOT does not change the sub-control node to the monitor even if a control
node shift occurs, so the monitor display of the pertinent device is interrupted.

Counter (C)

This is a device which counts the number of effective input items and turns on a contact point
when the number reaches the specified value. The counted value is cleared by using the Reset
command to reset the counter.

Cyclic (transmission)

With the MELSECNET, this is a function which exchanges data within the same network. The
following devices are used: the link relay (B), the link register (W), the link input (X), and the link
output (Y). For a GOT connected directly to the MELSECNET, B and W can be used as inde-
pendent node devices.
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— D

Data register (D)

This refers to a PC register used to store numeric values, and is called a “D register”. Sixteen-bit
or 32-bit data can be uploaded to a D register. Depending on the type of PC, real numbers can
be used in some registers, as well as integers.

Debugging (function)

This is a procedure which eliminates errors in the program contents and settings. With the GOT,
the user can instruct the system to check whether or not the screen displays are correct. The
graphics software has a “debugging function”. When the debugging mode is activated, the
computer assumes the role of the PC CPU and communicates with the GOT, as if the GOT
were connected to the PC, and a test is run to check screen displays and touch key input. On
the debugging screen, batch monitoring of device values can be done, changes can be made
to device values, the device status during debugging can be written to a file, and previous files
can be read out. This function cannot be used to operate the PC, however.

Default value

This is the initial setting. With settings such as GOT sprite settings, default values have been
entered for nearly all of the values, so the process of entering values can be eliminated.

Device

This is a general term referring to the memory located in the PC CPU. Various devices are
available, depending on the application at hand, such as input devices (X), output devices (Y),
and data registers (D).

Device batch change

This is a function which enables all of the device names for a sprite which has been specified to
be changed at one time. It is run by selecting “Device Batch Change” on the Edit menu. Specify
the names of the devices prior to the change, the names of the devices after the change, and
the number of points to be changed.
<Example> To change from 50 points from D100, to 50 points from D200:

D100 — D200

D102 — D202

D140 — D240

Display conditions (read conditions)

This is activated (display or reading of data) only when a specified condition is fulfilled. This
condition is called a trigger condition. There are six types of conditions:

¢ Always Data is displayed or read out on a constant basis.

* Rise Data is displayed only at the rise of the specified device.

¢ Fall Data is displayed only at the fall of the specified device.

e When on Data is displayed or read constantly while the specified device is on.

e When off Data is displayed or read constantly while the specified device is off.

¢ Timing Data is displayed or read at the specified timing.
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Display method

This enables the display color, movement, and other elements to be changed for each specified

screen. Up to eight types of ranges can be specified, including seven types + one other (nor-

mally). The range is specified as a comparison expression in terms of the monitor device value.
{Example) 100 < device <= 1500, etc.

Double-click

This means pressing the mouse button twice in rapid succession, without moving the mouse.
The interval between clicks can be specified by the user.

Double-click time setting

This is used to set the effective time for double-clicking.
<Procedure>
1. Boot the Windows “Program Manager”.
2. Select “Mouse Setting” under “Control Panel” on the Main menu.

Download

This refers to sending screen data from the graphics software to the GOT. Data can be sent in
screen modules, as comments, or by part, allowing only the data necessary for a particular
operation to be sent. Conversely, “uploading” refers to the process of receiving screen data.

Drag (dragging)

This means holding down the mouse button while moving the mouse.

-

Expansion cable

When the PC is connected to the GOT through a bus, an expansion cable is used between the
expansion base of the PC (the foundation base) and the GOT. Normally, the expansion cable
extends a total distance of 6.6 meters or less from the foundation base.

Distance expansion cables designed especially for the GOT, and cables designed to connect
several GOT modules using the A7GT-BUS, can be used for an expansion length of several tens
of meters.

Expansion file register

This is a register which is used to expand a file register in the memory cassette. The capacity of
the expansion file register is set by means of a parameter. The usable capacity which can be
specified varies depending on the capacity of the CPU and memory cassette being used.
With the MELSEC-A, the expansion file register is indicated by “R”.
With the MELSEC-QnA, the expansion file register is indicated by “R” and “ZR".
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_
Fall (trigger)

A device “falls” when it goes from on to off status. With the GOT, conditions which are displayed
only once when the GOT is turned off are referred to as a “fall trigger”. Please be aware that, if
the device is turned off and then is turned on again too quickly, there may be times when the
“off’ status cannot be detected, so that the fall trigger cannot be displayed.

If the “Initial Display” parameter is set to “On”, this is displayed once when the screen is switched,
even if the trigger has not been produced.

File register (R)

This refers to a register in the memory cassette. The capacity of the file register is specified using
a parameter. The capacity that can be specified depends on the capacity of the CPU and
memory cassette being used.

—_G—
GOT type

This specifies the GOT screen size. The screen size can be switched in the graphics software
based on this setting.

Graphic operation terminal

This is the term used by Mitsubishi Electric Corporation to refer to its display module. It is
abbreviated as GOT.

_—H—
Handle

This refers to small filled-in boxes displayed on the square surrounding a graphic when the
graphic is selected. When the mouse cursor is moved to a handle, the shape of the cursor
changes. If the left button of the mouse is clicked on a handle and the mouse is moved, the
graphic can be enlarged or reduced. Also, pressing the SHIFT key while doing this enables
proportional enlargement or reduction of the graphic.

_
Icon

This is a graphic pattern that you select {double-click with the mouse) when you want to run a
function like the ABGOTP in the Windows environment.

Icon button

The icon button is the button at the far right of the ABGOTP Application window, showing the
downward arrow. Clicking on this button displays the graphic software program in the form of
an icon.

Temporarily formatting the software being used as an icon enables other software to be run at
the same time.
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Index register (Z, V)

This is a register which is added to a device number, to enable the device address to be changed.
With the MELSEC-A, this is expressed as Z or V.
With the MELSEC-QnA, this is expressed as Z.
With the QnA, please be aware that “V” is an edge relay. Also, please be aware that the GOT
does not support an edge trigger device.

Input (X)

This refers to a signal input from a source external to the PC. Signals from limit switches and the
mechanical system are read and control is initiated by the PC.

Interlock

This is a block which is applied between the end of the operation currently being executed and

the next operation, to prevent the equipment from breaking down or running away. Normally, a

bit device is used to apply an interlock. This signal is called an “interlock condition”. With the

GOT, two types of interlock signals can be specified: display conditions and writing conditions.
Display condition : A check of movement conditions using an edge trigger or a level trigger
Display method : A check based on either the display range or the writing range

Internal relay (M)

This refers to signal information which is used within the PC and is not output to any external
destination. It is also called a temporary memory.

Internode test

With the MELSECNET, tests can be run to see if there are any problems with link modules or
cables between two nodes. The node with the smaller node number is checked as the main
node, and the other as the sub-node.

—K—
Key word

This is a kind of password assigned to a sequence program. The program cannot be loaded or
saved by anyone who does not know the key word.

_
Link relay (B)

With data links, this refers to a bit device which is transferred by means of cyclic transmission.
Bit devices can be assigned to the various nodes using link parameters, so that the data written
to each node is written only to the device assigned by the local node. Devices assigned by other
nodes can read out data, enabling data to be transferred between the various nodes.

Link relay (W)

With data links, this refers to a word device which is transferred by means of cyclic transmission.
Word devices can be assigned to the various nodes using link parameters, so that the data
written to each node is written only to the device assigned by the local node. Devices assigned
by other nodes can read out data, enabling data to be transferred between the various nodes.
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—_M—
Master node

With the MELSECNET, this indicates the PC which controls the entire network. The master
node has link parameters. If the master network becomes unable to function because of a
preblem such as a power supply failure, the network stops.

Maximum display

This refers to displaying the graphics software application or another application so that it fills
the entire screen.

Maximum Size button

The Maximum Size button is the upward arrow button located at the right end of the title bar in
the ABGOTP application window. Clicking on this button enlarges the graphics software to fill
the entire screen (maximum display).

Memory card

Because screen data can be stored in a memory, the memory card is convenient for high-speed
copying of data to another GOT. It conforms to JEIDA standards.

Momentary power failure

This is an extremely short power failure. With the PC and GOT, a power outage is only deter-
mined to be a power failure if it lasts for 200 msec or longer. If a power failure occurs which lasts
longer than this period, initial processing is carried out in the same way as when the power
supply is first turned on,

Move part (trajectory display)

This function deletes the part (graphic) displayed immediately previously, and moves the part to
a newly specified position (based on coordinate device values), where it is displayed. With the
“Move part” sprite, the user can instruct the system to leave the previous part displayed, instead
of deleting it. This is called a trajectory display of a part.

Multi-language system

The GOT supports approximately 26,000 characters of languages from all over the world as a
standard feature, so it can be used worldwide. Text can be input in languages such as Japa-
nese, Korean, and Chinese, using the FEP of the respective country.

_ N——
Node address (node)

This is a number assigned to each sequencer and GOT connected to the MELSECNET. Node
addresses cannot be used more than once in the same network.

Node number setting switch

With the MELSECNET, this is a switch used to set the node number provided for a link module.
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—O——
Operating system (OS)

This generally refers to basic software such as a calculator, and is used to run programs created
by the user. With the PC, this runs the sequence program, and with the GOT, it runs functions
such as setting the windows and touch keys. It is provided by Mitsubishi.

OS Install

This command installs the operating system from the graphics software to the GOT. This is
called the OS install function, and is run by selecting “OS Install” on the Communication menu.
With the OS install function, the user can select those functions which are necessary from the
list below and install them, for a customized operating system.

Basic functions

System monitor functions

Special module monitor functions

Circuit monitor functions

Communications driver
<Communications>

For the communications driver, always install the driver that has the name of the method

by which the PC is connected.

Output (Y)

This is the signal which outputs the results of PC calculations to an external destination when
turned on, and stops output when turned off. The device name is indicated by “Y”. There are
three types of PC output: relay, TRIAC, and transistor.

—_—P—
Panel kit (library)

This refers to a group of graphics or sprites which have a single meaning. The information for
these individual groups is the panel kit for that particular group. These can be pasted to the
screen and arranged in combinations to create a screen. A panel kit library is a configuration of
several panel kits registered as a group.

Part

This is configured of graphics, and is used in the “Display parts” and “Move parts” sprite func-
tions. Graphics that can be used in parts include text and image data.

Password

This is a code word specified to keep screen data from the GOT from being uploaded by
unauthorized persons. When screen data to which a password has been assigned is uploaded,
the registered password must be entered before the data can be uploaded.

Point

This means moving the cursor to the target position on the screen.
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Project (file)

A project is a collection of all of the information displayed on one GOT. A project consists of data
such as canvas graphics information, window screen information, and parts information. These
types of information (projects) are created in one directory. The file which handles overall control
of the project is called a project file, and is identified by the file extension “.SET".

— R—

Reversed screen image

When a hard copy of the screen image shown in the screen preview window is printed out, the
user can select whether to print the image as it is, or with the black and white sections reversed.
The output setting can be specified by selecting “Option” under “Print” on the Project menu, or
by selecting “Preview” under “Screen”.

Rise (trigger)

A device “rises” when it goes from off to on status. With the GOT, conditions which are dis-
played only once when the GOT is turned on are referred to as a “rise trigger”. Please be aware
that, if the device is turned on and then is turned off again too quickly, there may be times when
the “on” status cannot be detected, so that the rise trigger cannot be displayed.

If the “Initial Display” parameter is set to “On”, this is displayed once when the screen is switched,
even if the trigger has not been produced.

-—
Screen

There are two types of screens: base screens and window screens. Screens are composed of
canvases (graphics) and sprites (settings).

Screen switching

This refers to changing back and forth between a GOT canvas screen and a window screen. To
switch screens, one word device needs to be specified for each screen, the canvas screen and
the window screen. The device may be the sequencer word device, or the special device de-
signed for the GOT (GD) located in the GOT itself.

Screen preview

This is a function which enables a GOT screen display image to be re-displayed in the graphics
software. In order to display a screen preview, one of the four types of communications drivers
listed below must be installed, along with the driver containing the name of the method by which
the PC is connected.

Image : Displays the sprite display image produced when the GOT is run.

Device : Displays the name of the device specified by the various sprites at the

specified position.
Image + Device : Displays the images and sprites together.
Canvas : Displays only the fixed screen information, without the sprites.

Self-diagnosis

This is a function in which the GOT (CPU) detects errors within itself. The test covers the GOT
hardware, communications, memory, displays, and other aspects.
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Set

This means turning a specified bit of the PC bit device or word device on. The signal is kept on
until an RST (reset) signal is received.

Set value

This refers to entering values in advance for the PC timer (T) and counter (C). Fixed values can
be set and indirect instructions entered during the sequence program. With the GOT, monitor-
ing and changing of set values can be done from the system monitor screen.

Shift

This refers to moving word device data by a specified number of bits and changing the data.
There are left and right shifts.

In a left shift, the projecting information disappears, and 0 is entered as subsequent data. In a
right shift, the projecting information disappears, and where formerly there was a positive num-
ber, a 0 is inserted, and where there was a negative number, a 1 is inserted. '

Shortcut keys

This refers to a certain combination of keys which can be used to perform an operation, instead
of opening a menu. With the ABGOTP, the [Ctrl] key or the [Al] key is used in combination with
an alphabetic key.

<Example> [Ctrl] + [S] keys:
Entering this combination of keys while you are working overwrites the existing project data
and saves the revised data.

Special data register (D)/Special register (SD)

This is a data register {D) whose application is determined by the PC. It enables various types of
information such as the PC CPU information and MELSECNET information to be viewed.

With the ACPU, these relays are numbered DS000 ~ .

With the QnACPU, a dedicated SD device is used.

Special internal relay (M)/special relay (SM)

This is an internal relay (M) whose application is determined by the PC. It enables various types
of information such as the PC CPU information and MELSECNET information to be viewed.
With the ACPU, these relays are numbered MS000 ~ .

With the QnACPU, a dedicated SM device is used.

Special unit monitor function

With this function, the status of the special module can be displayed as a unit configuration
diagram, so that the module to be monitored can be selected. The buffer memory and input/
output status for the special module can then be monitored on the system screen, and changes
can be made to data. There are approximately 200 screens available with each special module,
for monitoring purposes. The screens for whichever module is required can be downloaded to
the GOT.

These screens are supplied with the SW***-A8GMDP.
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Sprite (setting)

This refers to information for moving images, such as numerical displays, parts displays, and
touch keys. Sprites are used to set monitor devices, movement conditions, and other informa-
tion. With this graphics creation software, sprite boxes are displayed using green lines.

Status bar

This is found at the bottom of the graphics creation screen, and displays information such as
guide messages and the cursor position. The user can select whether or not the status bar is to
be displayed using the “Display” parameter under “Option” on the project menu.

System information

This is information which conveys the GOT status (number of the screen currently being dis-
played, error numbers, etc.) to the PC, and information which is output from the PC to the GOT
(GOT error reset signals, etc.). It is set using word devices.

System information is specified by selecting “System Information” under the “Common” menu.
“Readout device” refers to the information read out from the GOT. “Written information” refers
to information written to the PC from the GOT.

System monitor (function)

This refers to the GOT system functions which handle device monitoring of the PC and writing.
In addition to individual nodes connected to the GOT, system monitors can also be set up for
the PCs of other nodes.

e Device group monitor/Registration monitor

¢ Buffer memory group monitor

® Device SET/RST

¢ Changes to buffer memory values

¢ Displays with comments

¢ Functions for changing other display formats

—_—T
Ten-keys

These are the keys used to input numeric values from O to 9. With the GOT, there is a system
ten-key word, so the ten-keys do not need to be set (created) on the screen.

Text file

This is a file which contains only alphanumeric characters and symbols. Comments can be
output to a text file and edited using an editor program. They can also be input to a file after
being edited. Also, the printing function can be used to output GOT screen information such as
sprite settings to a text file. This makes it possible to read the file with a word processor and
create original documents.

Timer (T)

This is a device which activates a timer coil following a specified period of time (the value set for
the timer), in order to delay or maintain an operation. Two types of timers are available: 10 msec
and 100 msec. The timer consists of a contact point, a coll, a current value, and a set value, and
on the GOT monitor screen, any values other than the specified value can be monitored and
written. Monitoring and writing of the set value is done using the system monitor function.

A-23
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Title (setting)

With the graphics software, the project title and screen title can be specified, by selecting “Set
Title” on the Common menu. These titles are used when information is output using the printing
function.

Project title: This is configured of the title information, the detailed information, and the name of
the person who created the data. |

Screen title: This is configured of the title information and the detailed information.

Title bar

This is the title bar displayed at the top of the application window in the graphics software, and
contains information such as the name of the graphics software, the title of the screen being
edited, and the icon button.

Tool bar (1/2)

This is a group of icons displayed under the menu bar, which can be selected for functions used
relatively frequently, instead of repeatedly having to open the menus. There are two tool bars,
and they can be displayed or hidden by selecting “Display” under the “Option” item on the
project menu.
Tool bar 1 : This group includes functions such as screen drawing, editing, and sprites.
Tool bar 2 : This group includes functions such as selecting the display color, line type, and
the distance by which the mouse moves.

Touch key
Touching the screen enables the screen to be switched and the data to be written to the device.
The minimum unit for the size is one character (16 x 16 dots).

Tri-layer

With the MELSECNET, the local node which is a two-layer “Child” node is used in conjunction
with the “Parent” node, and below that are local nodes or remote nodes which serve as “Grand
Child” nodes.

Transient transmission

With the MELSECNET, data can be read directly from a PC device of another node. If the node
number specified using the GOT monitor device is any number other than the node of that
device itself, transient transmission is carried out. Transient transmission requires a communi-
cations time several times longer than that of cyciic transmission, so when you want information
processed at high speed, it must be sent by cyclic transmission.

Two-layer

With the MELSECNET, this refers to a system configured of one master node and a local node
controlled by the master node or a remote node.

—_
Upload

This means using the graphics software to read data from the GOT. The data read from the
GOT can then be sent back to the GOT (downloaded) after it has been edited.
<Menu> [Communication] - [Upload]

A-24
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—_—
Vertex Edit

This is an editing function which makes it possible to change the positions of the various vertices
of continuous lines and polygons after a screen has been created. To access the function,
select “Vertex Edit” on the “Edit” menu. The mode will remain effective until the same item is
selected again. When the Vertex Edit mode is on, a check mark is displayed next to the item on
the menu.

—_W—
Window screen

This is a pop-up screen superimposed on the base screen. Touching the button at the upper
left of the window closes it. The first line at the top of the window contains the window screen
movement keys. Touching a movement key and then any other key moves the window to that
position, with the touched position serving as the upper left coordinates of the window.

Word device

This refers to a device which conveys 16-bit (word) information in a PC device. With the GOT,
word devices can be read in 16 or 32 bits. Also, the following types of data are supported:
integers with positive/negative signs, integers without positive/negative signs, and real num-
bers.

Word device set

This is a function which writes the specified value to a word device when a touch key is pressed.
Types of specifications include fixed values, values of other word devices, and the fixed value
added to (or subtracted from) the current device value.



WARRANTY

Please confirm the following product warranty details before starting use.

1. Gratis Warranty Term and Gratis Warranty Range
If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product
within the gratis warranty term, the product shall be repaired at no cost via the dealer or Mitsubishi Service Company.
Note that if repairs are required at a site overseas, on a detached island or remote place, expenses to dispatch an
engineer shall be charged for.

[Gratis Warranty Term]
The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated
place.
Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and
the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair
parts shall not exceed the gratis warranty term before repairs.

[Gratis Warranty Range]

(1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc.,
which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels
on the product.

(2) Even within the gratis warranty term, repairs shall be charged for in the following cases.

1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused
by the user's hardware or software design.

2. Failure caused by unapproved modifications, etc., to the product by the user.

3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions
or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary
by industry standards, had been provided.

4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the
instruction manual had been correctly serviced or replaced.

5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force
majeure such as earthquakes, lightning, wind and water damage.

6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.

7. Any other failure found not to be the responsibility of Mitsubishi or the user.

2. Onerous repair term after discontinuation of production
(1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued.
Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
(2) Product supply (including repair parts) is not possible after production is discontinued.

3. Overseas service
Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA

Center may differ.

4. Exclusion of chance loss and secondary loss from warranty liability
Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to damages caused by any cause
found not to be the responsibility of Mitsubishi, chance losses, lost profits incurred to the user by Failures of Mitsubishi
products, damages and secondary damages caused from special reasons regardless of Mitsubishi's expectations,
compensation for accidents, and compensation for damages to products other than Mitsubishi products and other duties.

5. Changes in product specifications

The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.

6. Product application

(1) In using the Mitsubishi MELSEC programmable logic controller, the usage conditions shall be that the application will
not lead fo a major accident even if any problem or fault should occur in the programmable logic controller device, and
that backup and fail-safe functions are systematically provided outside of the device for any problem or fault.

(2) The Mitsubishi general-purpose programmable logic controller has been designed and manufactured for applications
in general industries, etc. Thus, applications in which the public could be affected such as in nuclear power plants and
other power plants operated by respective power companies, and applications in which a special quality assurance
system is required, such as for Railway companies or National Defense purposes shall be excluded from the
programmable logic controller applications.

Note that even with these applications, if the user approves that the application is to be limited and a special quality is
not required, application shall be possible.

When considering use in aircraft, medical applications, railways, incineration and fuel devices, manned transport
devices, equipment for recreation and amusement, and safety devices, in which human life or assets could be greatly
affected and for which a particularly high reliability is required in terms of safety and control system, please consult
with Mitsubishi and discuss the required specifications.



SW3NIW-A8GOTP Graphic Settings Software Package

Operating Manual (Introductory Manual)

MODEL| SW3-A8GOTP-O-NY-E

MODEL 1DM177

IB(NA)-66792-B(0406)MEE

HEAD OFFICE : 1-8-12, OFFICE TOWER Z 14F HARUMI CHUO-KU 104-6212,JAPAN
NA 11-14, - - , HIGASHI-KU, NAGOYA , JAPAN

GOYA WORKS : 1-14 , YADA-MINAMI 5-CHOME , H

When exported from Japan, this manual does not require application to the
Ministry of Economy, Trade and Industry for service transaction permission.

Specifications subject to change without notice.



	Revisions
	About the Manuals
	Introduction
	1. Using the Manuals
	2. Abbreviations and Symbols Used in This Manual

	The Contents and Purpose of This Manual
	System Configuration Used in This Manual
	Table of Contents
	Chapter 1
	1. First, Let's Boot the Software!
	1.1 Learning the Basics
	1.1.1 Using the Mouse
	1.1.2 Screen Configuration

	1.3 Starting Up and Exiting the Graphics Software
	1.4 Learning the Overall Flow
	1.5 Operating After Starting Up Graphic Software
	1.6 About the Screen Images Shown in Chapter 2 and After


	Chapter 2
	2. Let's Draw Pictures!
	2.1 Learning to Draw Graphics
	2.1.1 Selecting Attributes
	2.1.2 Drawing Straight Lines, Rectangles, Circles, and Arcs
	2.1.3 Drawing Polygons and Continuous Lines
	2.1.4 Inputting Text

	2.2 Editing Data (Graphics and Sprites)
	2.3 Creating a Screen
	2.4 Saving the Created Screen Data
	2.5 Reading Data From a Floppy Disk


	Chapter 3
	3. Let's Get the GOT Going!
	3.1 Connecting the Computer and the GOT
	3.2 Installing the Operating System in the GOT
	3.3 Downloading Screens


	Chapter 4
	4. On the Move
	4.1 Connecting the Computer
	4.2 Monitoring


	Chapter 5
	5. Creating a Screen
	5.1 Setting Up a New Screen
	5.2 Making a Sample Screen
	5.3 Entering Sprite Settings


	Chapter 6
	6. Creating a Second Screen
	6.1 Entering Screen Switching Settings
	6.2 Making a Sample Second Screen


	Chapter 7
	7. Checking Movements
	7.1 Monitoring
	7.2 The Sequence Program Used for Practice


	Appendix
	Appendix
	Appendix 1. Supplementary Assignment
	Appendix 2. Getting Familiar With Terminology


	WARRANTY

